Windows7 ##& Android 7T K EBR/NXFE (Eclipse + ADT)

i Ei
=i S a5 Fuh
i ADT-0.9.6.zip 2010-03-31 22:54 7,282 KB
B8 android-sdk-windows-1.5_r3.zip  2010-03-31 22:55 186,991 KB
i Eclipse34.1.zip 2009-03-09 15:10 155,316 KB
| £ jdk-Buld-windows-i586.exe 2009-06-21 22:19 75,242 KB

WIN7 [)2567575 XP ey e e .

1. %% IDK

iz17 jdk-6ul4-windows-i586.exe

TrEluEh
15 (FHIShE T EA L -

Sun Microsystems, Inc. Binary Code License Agreement
for the JAVA SE DEVELOPMENT KIT (JDK), VERSION 6

SUM MICROSYSTEMS, INC. ("SUN") 15 WILLING TO LICENSE THE
SOFTWARE IDENTIFIED BELOW TO YOU OMLY UPON THE CONDITION
THAT YOU ACCEPT ALL OF THE TERMS CONTAINED IM THIS BINARY

CODE LICEMNSE AGREEMENT AND SUPPLEMEMNTAL LICENSE TERMS
(COLLECTIVELY "AGREEMENT"). PLEASE READ THE AGREEMENT
CAREFULLY. BY DOWNLOADING OR INSTALLING THIS SOFTWARE, YOU  _
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i IRE
Java DB
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0, EUEHRAR—15 Microsoft Office
RENDEEAODLEY
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ERL. SIBFRTE Microsoft Office 3014
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K fr IDK /2 52235 2. 4T/F emd & 1, %A java —version &% IDK [FRRAE B .

@ EER: C\Windows\system32\cmd.exe

Microzoft Windows [HF" . 6.1.766881
H F[_ﬁ Cc)» 2082 Microsoft Corporation.

C:sllzseprs~YOMORI *java —version

Java version “1.6.8_14"

Java<TM>» SE Runtime Environment C(huild 1.6.0_14-hB8>

Java HotSpot<TM>» Client UM <huild 14.8-bi6, mixed mode. sharing?

C:sllseprs~YOMORI >

2. #% Eclipse
HEEMRIEYE Eclipse3.4.1.zip #f5E H% 4: F:\Android\eclipse

v HEAL » EFHEESE (F) » Android » eclipse »
w
BEEER -~ HE - =1l s
-
e =i FEMHEH Foi =R
= . configuration 2010-03-31 23:39
im . dropins 2008-09-12 7:36
CEAEEEE . features 2010-03-31 23:59
! p2 Tanli I ok B |
. plugins =74
. readme 2010-03-31 23:59 T
22 . e nE19 7o B
" | | .eclipseproduct 2008-09-12 7:20 1 KB ECLIPSEPRODUC...
] |Z| artifacts.xml 2008-09-12 T35 09 KB
= = eclipse.exe 2008-09-12 7:20 56 KB
i 2 | eclipse.ini 2008-09-12 7:36 1 KB
B eclipsec.exe 2008-09-12 7:20 28 KB
3 5] epl-v10.html 2008-09-12 7:20 17 KB
£ | notice.html 2008-09-12 7:20 7 KB
£t
z

iz47 eclipse.exe, % & Workspace, f&%E Mk HFLEEHMATLL T



e Workspace Launc | ——

Select a workspace

Eclipse SDK stores your projects in a folder called a workspace.
Choose a workspace folder to use for this session,

Workspace: F\Android\AndroidDev

[ Use this as the default and do not ask again

FEUITFE, Eclipse %#5e

3. %% android-sdk-windows-1.5_r3.zip
Android SDK [f] Eclipse —#f, BEEME4EH LA, FRICMIELE R 092 F:\Android

a7 833FF - H= v @FE FEY

H . AndroidDev
| . android-sdk-windows-1.5_r3

BEAEREE i eciipse
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l. g BEES: C\Windows\system32\cmd.ex:

Microsoft Windows [H . b.1.76881]
i $§ Cc>» 2882 Microsoft Corporation. ﬁ%ﬁ

C:sllzers~YOMOX]I *android —h

Usage:
android [globhal options] action [action options]

Globhal options:

—h —help Thiz help.

- ——szilent Silent mode: only errors are printed out.

-y —uyerhose Uerhoze mode: errorsz, warnings and informational messages are pr
inted.

Valid actionz are composed of a verb and an optional direct ohject:
— list Lists existing targets or virtuwual devices.
list avd Lists existing Android Virtwual Devices.
list target Lists existing targets.
create auvd Creates a new Android Uirtuwal Device.
move aud Moves or renames an Android Virtuwual Device.
delete avd Deletes an Android Uirtuwal Device.
update awvd Updatesz an Android Uirtuwal Device to match the folders of a ne
SDK.
create project: Creates a new Android Project.
— update project: Updates an Android Project (must have an AndroidManifest.xml)>.

4. %% Android Development Tools (ADT)
¥ Eclipse IDE
HESEH A "Help" -> "Software Updates"

&j% Java - Eclipse SDI Q@_{g‘

File Edit Navigate Search Project Run Window

B oy f_':"
(oal Welcome 3 lde) Welcome

Help Contents
Search

Dynamic Help

Key Assist... Ctrl+Shift+L
Tips and Tricks...
Cheat Sheets...

Software Updates...

About Eclipse SDK

BENIETR "Available Software" -> "Add Site" -> "Location:"#i A

http://dl-ssl.google.com/android/eclipse



| Installed Software| Awvailable Software

type filter text Install...

Mame

[] %] Ganymede Update Site

[] %] The Eclipse Project Updates Eroperties

| AddSite.. |

’
= Add Site

Location: http://dl-ssl.google.com/fandroidfeclipse

| Installed Software| Available Software

type filter text = [ Install...

MName
] %] Ganymede Update Site
%] hitp://dl-ssl.google.comfandroid/eclipse
il Developer Tools
L Android DDMS
Yix Android Development Tools
] %] hitps://dl-ssl.google.com/fandroid/eclipse/
[] %] The Eclipse Project Updates

I Broperties ]

| AddSite.. |

I Manage Sites... ]

Progress Information

@ Calculating requirements and dependencies.

—% Next, VER Accept ¥Fr], HF|%E M.



Install

Review and confirm that the check

ed items will be installed.

Mame

Version

{[¥] % Android DDMS

0.2.6.,201002051504-24346

Y Android Development Toals

0.9.6.,201002051504-24846

Size: 9,373 KB
I Details

MNext = Einish

Review Licenses

Licenses must be reviewed and accepted before the software can be

installed.

5|

Items with licenses:

Mame

(g Android DDMS
L+ Android Development Tools

License text:

Mote: jcommon-1.0.12jar is under the BSD licens:
rather than the APL. You can find a copy of the BS
License at http:/fwww.opensource.orgflicenses/bs
license.php

I do not accept the terms of the license agreem

[“liAlways run in background:

[Run in Background

Cancel

|| Details > |

It is strongly recommended you restart Eclipse SDK for the changes to take
effect. For some add-ons, it may be possible to apply the changes you have
made without restarting. Would you like to restart now?

] IAppIy Changes

"Yes"# J5 "Eclipse", 5%,

5. &E"SDK Location"



#THF Eclipse IDE
HECE#F "Window" -> "Preferences”

Navigate Search ct Refr Help
New Window
New Editor
Show Toolbar

Open Perspective

Show View

Customize Perspective...
Save Perspective As...
Reset Perspective...
Close Perspective
Close All Perspectives

Navigation

Android SDK and AVD Manager

Preferences

T "Preferences"& M, %+ "Android"

pe filter text General

General
Android

Ant

Help
Install/Update

Java

[T Always run in background
[ Keep next/previous editor, view and perspectives dialog open
[ Show heap status

Open mode
@ Double click

Plug-in Development © Single click
Run/Debug Select on hover
Team Open when using arrow keys

XML MNote: This preference may not take effect on all views

o A A A A T L A v

I Restore Qefaultsl I Apply

ok || cancel

ANEG AR E O, B E"SDK Location"y SDK (435 H %,

.
= Android SDK Location - - ==

@ The location of the Android SDK has not been setup. Please go to
Preferences = Android and set it up




| type filter text

General

Android

Ant

Help

Install/Update

Java

Plug-in Development
Run/Drebug

Team

XML

Android

Android Preferences

SDK Location:  FiAndroid\android-sdk-windows-1. 5_r3|

Browse...

Mote: The list of SDK Targets below is only reloaded once you hit "Apply" or 'OK',

Target Mame

Vendor

Mo target available

Platform

APT ...

’ Restore Qefaults] ’

Apply

"OK"J5, HUATIFRAE N, /77 IFEF] SDK 13

pe filter text

General

Android

Ant

Help

Install/Update

Java

Flug-in Development
Run/Debug

Tearn

XML

Android

OK

|| cancel

Android Preferences

SDK Location:

Fhandroidyandroid-sdk-windows-1.5_r3

Browse...

Mote: The list of SDK Targets below is only reloaded once you hit 'Apply' or 'OK.

Target Mame
Android 1.1
Android 1.5
Google APIs

Vendor

Android Open Source Project

Android Cpen Source Project

Google Inc.

Platform  API ..
11 2
1.5 3
15 3

I Restore Qefaultsl I

Apply

6. WHEH RIEE, FHA1E HelloWorld MliF2)+
N Eclipse IDE zH.H1H) "File" -> "New" -> "Project"

(9]¢

|| cancel




.- — Java - Eclipse SC

[File | Edit Run MNavigate Search Project Refactor Window Help
New Ale+Shift+M ¢
Open File...

Java Project

Project...

Close Ctrl+W
Close All Ctrl+Shift+ W

Package
Class

Save Ctrl+5 bl bse
Save As.. EiI
Save All Ctrl+Shift+5

Revert

Annotation
Source Folder
Java Working Set
Folder

File

Untitled Text File
JUnit Test Case

Mowve...
Fename...
Refresh

Convert Line Delimiters To

lOEmRrieeees® 1

Print... Example...

L=

Switch Workspace Other... Ctel+N

|
L

Restart

#F# "Android Project" F—&

- — —
= Mew Project E@g

Select a wizard

Wizards:

type filter text

2% Java Project -
# lava Project from Existing Ant Buildfile
2 Plug-in Project
> = General
4 = Android
2% Android Project|
Ji Android Test Project
[» = CVS
[ = lava —
i = Plug-in Development

m

3] = Back Mext = Einish Cancel

Z NRSEWEAGENIEE, GESEHGA—F, wWHRiE Androidl.5, "Min SDK Version" —E#& 3)



New Android Project - -
/Iy The API level for the selected SDK target does not match the Min SDK '#l

version.

Project name: | [glEl=y0isnls)

Contents

@ Create new project in workspace
(") Create project from existing source
Use default location

Lacation: | F:/Android/AndroidDev/HelloWorld Browse..

(C) Create project from existing sample

Samples: | ApiDemaos

Build Target

Target Mame Vendaor Platform  API ...
[ Android 1.1 Android Open Source Project 11 2
Android 1.5 Android Cpen Source Project 15 3
[[] Google APIs Google Inc. 15 3

Standard Android platform 1.5

Properties

Application name: HelloWorld

Package name: crn.younext

Create Activity:  HelloWorld

Min SDK Version: 1

Window Help

WA 32 F 350 H



F s

Eile Edit Run Source MNavigate Search Project Refactor Window Help

wil Eald H-0~-q-~ i (& Java |

I.JL‘:’ -EE;’ G’ - lE -,J.:. - - - - -

{% Package E 2 s Hierarchy| = O = O || 5= Outline 2 = 0O
==A = An outline is not available.

4 h% HelloWeorld
: 2B src

- =i Android 1.5

EEy assets

= res
1 AndroidManifest.xmnl

= default.properties

{2¢ Problems &3 @ Javadoc| |, Declaration| ~ = O
2 errors, 0 warnings, 0 others

Description Resourn

€ Errors (2 items)

BTk Android EBH#lE& AVD
TP cmd #4114, $47 android list target &E AT &

Microsoft Windows [H . b.1.76881]
$§ Cc> 2882 Microsoft Corporation. -

C:sllzeprs~YOMOE] *android list target
Availahle Android targets:
id: 1

Mame: Android 1.1

Type: FPlatform

APl level: 2

Skins: HUGA <default>,. HUGA-L, HUGA-P, QUGA-L. QUGA-P
id: 2

Mame: Android 1.5

Type: FPlatform

APFI level: 3

Skins: HUGA <default>,. HUGA-L, HUGA-P, QUGA-L. QUGA-P
id: 3

Mame: Google AFPI=s

Type: Add—On

Vendor: Google Inc.

Description: Android + Google APIs

Bazed on Android 1.5 CAPI level 3>

Libraries:

#* com.google.android.maps <maps.jar?

API for Google Maps
Skins: QUGA-P,. HUGA-L,. HUGA <default)>, QUGA-L. HUGA-F

C:sllzers~YOMORI >

H#% android create avd -name <AVD % 7> —target <id> #%6J& AVD.

C:-lzers~¥YOMOXI >android create avd ——name gdk 1 5 ——target 2




C:slUzers~YOMOEI *android create avd —name sdk_1_5 —target 2
Android 1.5 iz a basic Android platform.
Do you wish to create a custom hardware profile [nhol

C:sllzers~YOMOEI *android create avd —name sdk_1_5 —target 2
Android 1.5 iz a bhasic Android platform.

Do you wish to create a custom hardware profile [nol

Created AUD ‘sdk_1_5' based on Android 1.5

XEERLZERC T B € X Android Virtual Device
B®J5, BE "Eclipse" K "Run Configuration"
HEASKEHE AR "Run”

File Edit Mavigate Search Project Refactor Window Help
=% » | @, Run Ctrl+F11

L

3 B ( %, Debug F11

-> "Run Configurations"

5}] Java

= O

An outline is not available,

Run History
Run As

{8 Packag o= Outline &2

Run Configurations...

B

Debug History
Debug As
Debug Configurations...

T v

Al B ado oo

X iFi"Android Application" iz —ANF FIBLE SCfF, W E Name Ti

Create. manage. and run configurations

@ Project Name is required!

TEX B R
| ™ Mame: HelloWorld

type filter text

=] Android . Bl Target| = Common

4 [3] Android Application .
Project:

[T] Mew_configuration

Ji Android JUnit Test
& Eclipse Application
E Java Applet

3] Java Application

Launch Action:
@ Launch Default Activity

Ju JUnit Launch:
Ji JUnit Plug-in Test

&4 0O5GI Framewark

Do Nothing

fe A" Android"iE& i+ "Project" I H

MName: HelloWorld

=] Android . B) Target| = Common
Project:
HelloWeorld Browse...

Launch Action:
a LELIF‘"I" Dol s A £ o8
= Project Selection l

S

Lau

Do | Select a project to constrain your search.

........................

= HelloWorld:

........................

fEAM" Target"iE Uik 2% 5 )@ "AVD", "Apply"J&5, "Run"



MName: HelloWorld

fE| Android |B) Target - 2 Q::rmm::rﬂ

Deployment Target Selection Mode

7 Manual

Select a preferred Android Virtual Device for deployment:

AVD Mame Target Name

Platform API Le... Details...
sdk 15 Android 1.5

1.5 3
Start...

Manager...

—

Emulator launch parameters:

Metwork Speed: | Full -

%0 5 3077 X "Android Appliaction”

-
= Run As p|elEl

Select a way to run 'gen’

‘Android Appl ication;
Ell Java Applet

1 Java Application
Ju JUnit Test

Description

Runs an Android Application

@ | ok || cancel

IEH G DL BZ AL AT LA BIRIDLES S



# ° Android Emulator (sdk_1_5_version:5554) = l =

g Bl @ 6:22 M
8 Google Search

120 34 e Sl el ol (gl 19 o
Q| Wi B IR ) el [0 [l |8
AN S D REL (s Il e i i
¥ 2| X0 G M| B ENE M =
M @ 2|

Dialer Contacts Browser

ERPIXIAH T RHR,

[2010-04-01 02:16:07 - HelloWorld] Automatic Target Mode: Preferred AVD 'sdk_1_5"is not available. Launching new
emulator.

[2010-04-01 02:16:07 - HelloWorld] Launching a new emulator with Virtual Device 'sdk_1_5'

[2010-04-01 02:16:07 - Emulator] emulator: ERROR: unknown virtual device name: 'sdk_1_5'

[2010-04-01 02:16:07 - Emulator] emulator: could not find virtual device named 'sdk_1_5'

JR AR FFE S RE R MyDocument SCF3%, & MyDocument FT7E SCH4 I AR B 3k 3 ".android" ek, S#%] "C:\Users\[ X4 #1H
&1 B

Ctrl+F11, It A

WERIEA RIS, 23K "Project”" -> "Clean" 4uiHiH, =HA R

Vengen

2010-04-01 %=



